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09 Web Graphics 
6.1 Know your editor 
There are a lot of great graphic editors on the market today, which have a wide range of tools to 
help you design good-looking, professional graphics. Don’t be fooled though. A good graphics 
editor won’t make you an artist any quicker than a good word processor will make you a poet. It 
takes practice and experience to develop a good eye for design. 
Having a good editor can go a long way to helping you develop those design skills and becoming 
familiar with your chosen editor can make a big difference. Despite the wide range of features 
present in most graphics editors, many of them cater mostly to printing without many features for 
web graphics. Some recent products such as Adobe Image Ready (included with Photoshop 
version 5.5 and above) and Macromedia Fireworks aim to change that by providing tools 
specifically aimed at web graphics. There are however, a lot of valuable techniques that can be 
used in most good editors. 
This chapter aims at providing you with some tips that can be used in most graphic editors to 
create graphics optimised for the World Wide Web. Although the exercises will be set out for 
users of Adobe Photoshop CS, these techniques can be used in any editor with standard image 
editing features. Most of these tips will be for editing GIF files. This is because JPEG files aren’t 
much different from other file types with the exception of choosing the amount of compression 
when they are saved.1

                                                 
1 For differences between GIF and JPEG images, refer to 
http://www.oneil.com.au/pc/general/CommonRasterImageFormats.pdf  
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2 Colour issues 
Many web designers work on computers that can display millions of colours. Don’t assume that 
everyone visiting your website enjoys the same luxury. Most computers these days, however, can 
display at least 256 colours. The problem is that these 265 colours may not be the same from one 
computer to another, or even from one browser to another. This means that the colours in your 
graphics may not appear the same to others as they do to you. If specific colours are important, 
this can be a problem. Microsoft Windows and Apple Macintosh computers both have a set of 
256 standard colour but only 216 of those colours are the same in both operating systems. 
If a computer doesn’t have a colour you are using dithering will occur. Dithering uses different 
coloured dots to simulate a certain colour. Eg. 

Non-
dithered 

Dithered 

  

 

Browser safe colour palettes 
Many graphic editors include a “browser safe” colour palette. This is basically a collection of 
216 colours that can be safely used in most browsers and operating systems without being 
dithered. If you choose colours in your image from such a palette, you can be pretty sure that the 
colours in your image will look right everywhere. 
 

Exercise 1 Selecting a Colour Palette 

The following exercise uses Adobe Photoshop 5. If you are not familiar with this application, your instructor will 
direct you. 

1 In Photoshop, make sure your Swatches palette is showing. 
2 Click the triangle  in the top right corner of the palette to access the palette menu. 

 
3 From the menu select replace swatches. (Use load swatches if you want your old colours to remain in 

addition to the new ones) 
4 Browse to the folder where Photoshop is installed and find the folder called color palettes under the folder 

called goodies 
E.g. C:\Program Files\Adobe\Adobe Photoshop CS\Presets\Color Swatches 

5 Open the file called “Web Safe Colors.aco” 

Tip When using hexadecimal colour codes in your html, codes with pairs (eg. #FF00FF), will be 
browser safe. Others (eg. #98D0F8), won’t be browser safe. 
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3 Pixel Depth 
When you save an image as a GIF file you are restricted to 256 colours. This may not sound like 
much but it is often a lot more than you need. Reducing the number of colours in an image often 
won’t have any visible effect on the quality, but it will have an effect on the file size. Knocking a 
bit off the size of each of your graphics adds up and it can all make a big difference to how 
quickly your pages load. 
An image’s pixel depth determines how many colours it has as the following table illustrates. 
The last column shows the approximate file size for a colour image that is 100 pixels wide and 
100 pixels high. 
 

1 
bit 

= 
21 = 2 = 2 colours 351 

bytes  
2 
bit 

= 
22 = 2x2 = 4 colours 531 

bytes  
3 
bit 

= 
23 = 2x2x2 = 8 colours 894 

bytes  
4 
bit 

= 
24 = 2x2x2x2 = 16 

colours 
1511 
bytes  

5 
bit 

= 
25 = 2x2x2x2x2 = 32 

colours 
2104 
bytes  

6 
bit 

= 
26 = 2x2x2x2x2x2 = 64 

colours 
3050 
bytes  

7 
bit 

= 
27

= 
2x2x2x2x2x2x2 

= 128 
colours 

4504 
bytes  

8 
bit 

= 
28

= 
2x2x2x2x2x2x2
x2 

= 256 
colours 

5925 
bytes  

 
Notice that in the last few instances it is difficult to spot any difference in the quality of the 
graphic but there is a considerable difference in file size. With some graphics, like the one below 
you may be able to reduce the bit depth to as little as 4 colours without any noticeable loss in 
quality. 
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Exercise 2 Pixel Depth 

1 Open the file cougar.bmp 

2 From the Image menu select Mode, Indexed color. 

3 Make sure the Preview check box is selected so your image will update to show you the effect of changes. 

4 Change the number of colours from 256 to 128 and click OK. 

5 Save the file as cougar1.gif (non-interlaced). Close the file. 

6 Re-open cougar.bmp. 

7 From the Image menu select Mode, Indexed color. 

8 Select different pixel depth / colour values. Watch the picture as you select each option and note any 
change in quality. Select the smallest pixel depth you can get without too much noticeable loss in quality. A 
pixel depth of 5 or 6 should be about right. Click ok 

9 Save this file as cougar2.gif (non-interlaced). Close the file. 

10 Look at the files in windows explorer and compare the file sizes. 

11 Open both pictures in your graphic editor and compare them. 
 

 

4 Transparent GIFs 
One of the great advantages of GIF files is the ability to make part of them transparent. When 
this type of GIF image is used in a web page, the background will show through the transparent 
part. So this means that all you need to do is make the background of your picture transparent 
and all will be fine right? Unfortunately, it’s not that simple. Often the edges of a picture will 
blend with the background. Consider the following examples. 
 
 
 
 
 
In this example where white became the transparent colour, only the section marked would 
become transparent. That would be fine on a light background, but what if we put the same 
picture on a darker background. 
 
 
 
 
Although white is the transparent colour, the areas that aren’t quite white won’t be transparent. 
This means that the edges will stand out against the background, which is normally not what you 
would want. To get around this problem, it is best to make sure that the colour in your picture 
that you want to be transparent is similar to the colour of the background that will show through. 
The following exercise will illustrate how much difference this can make. 
 

Tip If you are saving an image in .png format you can have partial transparency, 
though many browsers, such as Internet Explorer don’t support this feature. 
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Exercise 3 Transparent GIFs 

In this exercise we will create a gif with a transparent background to replace the image at the top of our navbar. We 
will also look at Photoshop’s Save for Web option. (The image itself is no different, but you’ll get a chance to do it yourself) 

12 Open the file called cougar white.bmp 

13 From the File menu select Save for Web. 

 
Click the 2-up tab at the top to see a preview of your modified image next to the original image. Below the image is 
an estimate of the file size after saving. The options on the right allow you to change image settings. 

Set image type to GIF 

 

14 Click on the eyedropper icon.  

Select an appropriate number of colours 

 

15 Under the colour table, click the transparent icon.  

16 Click on the part of the image you want to be transparent (white). You can select more than one colour to 
be transparent. In the Colour table, each transparent colour will have a line through it.  

17 Click Save to save the file in your pics folder with the name nav_logo.gif, overwriting the existing file. 

18 Preview frames.html in your web browser. Note that the ‘not quite white’ parts of the image contrast with 
the background, creating an unsightly edge. 
Now we’ll try it again with another copy of the image that has a background colour more closely matching 
the background of the website. 

19 Open the file called cougar green.bmp 

20 Repeat steps 2 through to 6, this time choosing the green background as the transparent colour. 
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5 Animated GIFs 
A large portion of animation on the World Wide Web is accomplished through GIF files. Most 
GIF files are in the GIF89a standard (guess what year this standard became available!). This 
allows for transparency and interlacing. The GIF89b standard supported by most web browsers 
goes one step further by also allowing for animation. Animated GIF files consist of several 
images displayed in a sequence with a specified delay between each. Most graphic editors can’t 
display the animation, as it will appear in a browser. For this reason, several software 
applications have been developed with animated GIFs in mind. In the following exercise we will 
use Microsoft’s free GIF animator to work with animated GIFs.2
The images in an animated GIF don’t have to be the same size. In fact, having smaller GIFs in 
your animation can reduce the file size as the following example illustrates (some animated GIFs are 
painfully slow to download).  
Here are three images that will be used to create a GIF animation (the second image is repeated as the 
image loops):  
 

1.  2.  3.  2.  
 
Notice that in each image, only a small part is changing (the winking right eye). Instead of 
replacing the whole image with each step, the file size could be significantly reduced by 
replacing only the part that changes as in the example below: 
 

1.  2.  3.  2.  
 
The smaller images are positioned in the appropriate places e.g. 60 pixels right, 35 pixels down 
(the distance can be measured in your graphic editor). Because the animation is made up of 
smaller images, the files size is greatly reduced. 
Both of these animations look identical when put together. The difference? 5.7 kilobytes vs 19.7 
kilobytes! 
 

Note The latest versions of Photoshop include Image Ready which has good animated GIF editing 
features. Macromedia Fireworks also allows the quick creation of animated GIFs. 

                                                 
2 You can download a copy of GIF Animator from http://www.oneil.com.au/pc/html/ 
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Exercise 4 Animated GIFs 

In this exercise we will create the animated gif from the second example above using Microsoft GIF animator3. 
Once the animation is finished, it can be placed in a website like any ordinary GIF image. 

21 Open GIF animator. Click the file open icon  and open the file animation1.gif 

22 Click the insert  icon to insert a new picture. Insert the picture called animation2.gif. Click the icon 
again to insert the file called animation3.gif. 

23 Use the move up and move down icons  to ensure that the pictures are listed in the correct order (1 
at the top, 3 at the bottom). You can also change the order of images with the  and  keys on your keyboard or by 
dragging them with your mouse. 

24 Click the Animation tab. Make sure Looping and Repeat Forever are both selected. 

25 Click the Image tab and click on the first image. Set the Duration to 200 (2 seconds) and set Undraw 
Method to Leave (Setting it to Leave means that this picture will only replace parts of the previous picture that it 
covers. Any parts that aren’t covered will remain. This setting is important for the smaller images). 

26 For the second image, set the duration to 10 (1/10 second). Set the Undraw Method to leave. Position the 
image by setting left to 58 (58 pixels from the left) and setting top to 31 (31 pixels from the top). Repeat these 
setting for the third picture. 

27 Select the second image and click the copy icon . Click the past icon  to paste a copy of the second 

image. Use the up and down arrows  to position this copy after the third image so that it becomes 
the fourth image. Ensure that this new image has the same Image settings as the second and third one. 

28 Click the preview icon  to see how your animation looks. 

29 Click the save as icon  and save your file as animation.gif. 
 

 
 

                                                 
3 You can get a copy of this program from the Other HTML Resources section at http://www.oneil.com.au/pc/html/ 
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